
Greoframe 软件基本知识 
 

一、Greoframe 4.03模块简介（2002.8 ） 
G包——地质包             P包——测井包           Reservion——油藏包 
可视化                   seismic                     工具包 

数据管理：工区管理  project 
          过程      process 
          数据管理  Data 
 
G包中——Greology office 地质办公室 
          well composite 单井综合柱状图 
          well pix       测井曲线名井地层对比 
          Ressum       储层参数集总 (储层统计) 
          Cross section   油藏剖面的绘制 
P包中-------well edit       井校正,测井数据.岩芯数据等编辑及函数运算 

ELANplus      测井解释 
Rockcell        岩性分类  多井岩性/岩相判别 

Petrostat   Geoplot 多井交会图显示,数据标准化与曲线关系拟合 LithoQuick Look. 
 
二.Geoframe 4.03工区管理 
(一).建工区及工区备份 

工区建立有两种方式:1.产生新工区,2.恢复工区(从本机或其他机备份数据工区的
概念:小(20兆). 中. 大(120兆) 

工区放井与 2D导航数据在 oracle数据库中,如果工区选择小的话,当井与 2D导航数
据增大时,它会自动扩容,建立表空间,作分散管理,这样工区的运行速度将变慢. 
 
工区的内容: 

----stand lone  多用户 
----share project(只放井的工区,只能读井的数据)不能完成井的解释任务 
----sub project(Geofame project)工区 

 
工区管理 

Storage      系统设置  数据放在何处 
Edit         改变工区参数不合理的地方 
Delete       删除工区 
Merge       合并工区,通常情况不用,拷贝其他版本.不用的代码 
Backup      备份工区 
Recover      恢复工区 



 

Access rights 
Rebuild zndexes   自动做整个工区,提高速度,一般先要作备份 

 
工区备份 

Backup-----Acrchive*.gfa完全备份  产生的*log文件有些有用的信息 
Fast-backup*.gfb增量备份 

recover恢复增量备份  恢复完全备份 
 
选择性备份 

1  解释输出(在 Seismic中 Data manage) 
2  Data Save(well Data)将整个油田井数据备份 
3  2D Seismic校正好的 Class包括加载定义一起备份 
4  在CP备份整个CP 目录,作一个 tar文件(包括网格文件)从工区输入 (CP是个单

独模块,可以放在任何一个工区下运行) 
 
使用命令备份 

remoto—gen---save.csh选择性备份 
restore:remite—recover.csh 
 
关于基准面的问题:  (Data Manager Users Guide---AppendixA) 
ER    (elevation   Reference) 
EIT   (elebation  at  Time  zere) 
 

建工区 
给工区名——确认口令——从 DBA选工区的大小。类型——DBA注册——连接数

据库 分配空间 分开管理（解释 地震 速度 CPS 缺省）——创建工区的参数（米制） 
地震基准面 
  North American 27     clake1866 
  OTM zone number——19     zone代理很重要 

 
（二）地震数据的加载与备份 

1  SEGX  Dump:      带是否可读 
                      测线名字道头位置 
                      shotpoint的数及在道头位置，增量是正是负 
                      采样率是否正确（必须是用微秒） 
                      样点数是否正确 
                      有无坐标及在道头位置 

EBCDIC (Extended  Binary  coded  Decimal  znterchange  code)计算机对符号的
代码 
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3200bytes       400bytes     240         240⋯⋯ 
reel header       line头       trace1       trace2        End of File mark 
卷头           二进制       二进制道头               End of Tape mark 

one at the end of each file                        (EOT) 
two EOT’s mark on the end of tape 

 
2  SEGY   formate  line  header 

1 Sample  rate  4000 microseconds=4ms 
2 Number  of  Sample  pertrace 
3 Data  Sample  formate   code   1—IBM32—bit浮点  （4byte per sample） 
                               2—IBM32—bit整数  （4byte per sample） 
                               3—IBM16—bit整数  （2byte per sample） 
                               4—32bit point with gain（4byte per sample） 

 
Sample  rate(ms) *(number  of  Sample)=length  of  the  trace 

4               1000                 4000 
Full  Dump  (完全 Dump) 

2D 定义  * loc            line     CDP        x    y 
3D定义 3个点  面元大小 

 
3  在 seismic中 Data  Manager  (详细见   中的数据管理) 

1 地震 seY输入 输出 
2 删除。拷贝。层位。断层输入输出   （缺省格式） 
3 产生。改变 class，重新命名测线，产生 Time。Slice 切片 
4 二维测站，删除等 
5 surface管理    可以转换为层位              
提供 IESX—UTIL恢复工区    cd  IESXPROG 
定义格式        line   read       表达式 expression  trace  read                        

6 2D测线加入中带桩号（找到对应关系） 
 

（三）数据加载及备份 
           井数据      name     checkshots 

OWI     marker 
API      log dat 
bottom    location 
hole      condition 
index 
elevation   information 
flow       direction 
deviation   surrey     



 

  井数据加载     ASCII加载 
                        Data  Load 
         井数据备份     在井的各数管理中备份（打印输出） 
                        Data   Save 

 
1  关于 KB的问题 

KB不是补正高，它是井到 project  reference 之间 SCB 
         Checkshot  depth  datumn    USP处理针对哪一个面做的 

加井时 well—Borehol—加 elevation—Reference 
    

2  ASCII加载            （控制文件   批加载） 
          Data——ASCII  Load           Wu-ascii 
                                        Wu-galoaden*.ctl(放在缺省目录下) 
     (1) 井位加载     文件: 井名   x   y 
            well.ctl                 g25 
            Name     well            1 
            OWI      Borehole        1 
            Location   x              2 
            Location   y              3 
     (2) 井曲线  (log  data)    (单井加入) 

原文件:    井深     las1      las2 
控制文件  log.ctl 

DT           us/m        2 
RHOB        g/cm3       3 
GR           gAPI        4 

(3) 井分层  (well  marker  data  )  (多井加入) 
原文件 :  井名           分层            测深 
          g23             23             ^^^^^ 
          g23             32             ^^^^^ 
          g24             23             ^^^^^ 
          g32             32             ^^^^^ 
控制文件: (marker.ctl):    Borhole-name   start-wam     1 
                       Depth/Time                  2 
                       Name                       3 (marker ram)   

(4) 井斜 (well  deviation  survey) 
  原文件:  井名  MD   垂深  东分  北分 
 控制文件   MD      m1                  M D      m1 
             MD      m2                  TVD      m2 
             DX      m3 （单井加入）            D X      m3 
             DY      m4                   D Y      m4 
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   在 Borehole  UIM  (1)多井装入 
 (5) 井的 Checkshot   (well  checkshot  survey) 
   原文件               TVD         Time(s) 
   控制文件              TVD         m 
   (checkshot.ctl)      TWOTIM     s 
    装入给出是给出井名 （一个工区允许有多个 checkshot,也可把  速度按
这种方式装入） 
 (6) 离散文件装入 （Scatter  set  Data） 
    原文件    X         Y       Z         (如平均速度) 
  控制文件   X         1 
                 Y         2 
                 Property    3 
UWI   (Unique  well  Identifier)    井名（最长 40） 
API    (the  American  Petroleum  Institute) 
Well   name   属性用于区分多个版本，别各针对井，也用于家载 DLIS数据 
DLIS   (Digital  Log  Interchange  Standard) 
LAS    (Log   Interchange  Standard) 
Well  composed  of  Multiple  Boreholes 
Elevation        是到参考面 datumis 垂直距离 
MD    (Measured  Depth) 
True  Vertical  Depth  (TVD) 
Two   way  Time     (TWT)     (需要做校正) 
 
Borehole  working  Datum    Depth  Grid   工区工作 datum 
Wellcheckshot   Datum 
Well  Deviation  Datum 
Well  Marker  Datum 

 
3．井数据 Data  Load 加载 

Data   Load       *.gf66 
                  *.Lis 
                  *.Dlis 
对油田井打包后加入，加的是二进制的文件，只看到文件的头， （preview 可以

查看） 
如果想选择性加入一些曲线，则——Library  Filter  option 
1不过滤.       单个文件     DLIS 

4. 井数据备份    （井的数据直接在数据库） 
1 将井的各种数据在各数据相应的管理窗口备份 
  选择所要输出内容   （小打印机）输出 
  选上 well  symbol   (SPACE)空格 



 

2 Data  save——打包 
Archive  *.gf66   所有井数据 
DLIS            二进制测井曲线 
ASCII  x .  y . marker 

在 Data—general—右键—弹出油田—弹出油田有关井信息   打开 TTC转输 
在 Data  save  下井数据会自动显示 
    如果选 ASCII—no         Depth  index 
                             muti  borehole   and  producer 
在 LIS格式下 File number   1  代表每口井的数 
                          2 
                          3 
     每口井输出后需要 Apply    单口井输出  marker—ASCII中—well marker 

3在 CPS中——井数据可以打包 
                                     
(四)常用一些命令       (gf-db-admin.fm) 

1. 在 Geoframe  xterm  window 
启动  proman  Q 

2. $CL-f 
1 $CL-f-project  name  查看谁在用计算机 
2 $CL-f   project   project  password       解锁 

3.  gf-users   查看本机工区运行情况 
        client___ID  process 
4.  gf__accounts       查看机本机名字,分配的 oracle 

gf__accounts-o    (每个工区的所有元) 
gf__project-users 
free  space 
project__pass   proj-changepasswd   允许DBA或用户来改变它们工区的口令 
proj__delete    工区   工区口令 
   __update 

 
三  合成记录制作,时深关系建立 (synthetrcs) 

seismic---IESX---Application      Synthetics 
seismic---synthetic 
                          sonic logs        声波 慢度 
选井---post---Time/Depth     check shots       两者任选其一 
 
1不用 checkshot,时深关系从声波中提取,可用 correction  velocity给初始速度值  
2用 checkshot.    (校正声波用 checkshot)选 checkshot 
post---sonic      scale       marker       Reflection    coefficient 
      曲线      刻度       分层     
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      wavelet    seismic     correlation    Auxiliary  log                                
   子波       地震(井旁道)  
其中子波可以在 Tools---通过井旁道提,对子波编辑,分析,输入输出 
Tools---漂移及局部拉伸 

     
在子波分析---Time  varying 
 
在面版 seismic右键弹出选 borehole---在井柱上选---appearance---出现窗口 borehole  
appearance  可贴上合成记录(直接在合成记录的窗口)   
Tools—Backshif  在声波,marker上漂.虽在时域工作 

互校正了时深关系  (整体漂移)  
           stretch-sqeeze  局部拉伸   选停泊点 anchor停泊    
                                   2键选点   1键拉伸 
           relocity  surey  编辑 checkshot后校正声波曲线 
           wavelet      Extract 
                       Analytical 
                       Edit 
                       Time  varying     产生时变子波 
                       Import/export 
合成记录完成后   三键---Save存在合成记录---在地震解释在Borehole appearance 中完
成合成记录定义---update well (更新井集)再贴在剖面上（表现一道或多道） 
在 Tools---Synthetic---上下键   记住时间值，回到合成记录中，重新做合成记录  
 
四 .地震资料综合解释 
              Interpretation:                 2D/3D综合解释，底图 Basemap 
              Data  Manager:               数据管理 
              Computation  Manager         属性计算，方差体 
              Mistie  Analysis 
              Automatic  Picking            自动追踪 
 IESX         Surface Slice 
              Synthetics                    合成记录制作 
              Geoviz                       可视化 
              Geoviz  expore                 
              Basic  TD                    时深转换 

Interpetation  Model  Manager   解释模型管理 
 
(一) 解释模型管理 
启动 Interpretation   Model  Manager 
----选Model                ----Populate 
   创建Model                 合并 



 

----两种方式  1  Assign  全拷（会覆盖相同的层位） 
2  Clone   拷贝（选择性拷贝，不会覆盖相同的层位） 

选 Source  Model   对要拷贝层位，断层  选择 
 

（二）自动追踪  Automatic  Picking---ASAP   AutoPix     算法不一样 
ASAP(Automatic  Seismic  Area  Picken) 
----在 Edit定义一个 Seismic  Area  Path  多边形 
----数据种子类 
Area 断层边界     Tracking  option 
追踪方法----先作 Advanced 
追踪的数据在 Horizon  Function----Attrebute Erase  删除 
最好先备份在解释窗口 Areal----Horizon  Copy 备份下换成另一个名字，再做自动

追踪或删除 
 

（三）数据管理  Data  Manage 
在 IESX放的数据     3D/2D测线  工线   Surface(层位，断层) 

解释（属性，断层 Cuts, Contacts） 
网格文件 

         在 Geoframe 中所有的 3D层位属性存在数据库以网格形式 
2D层位属性以线数据存在 Geoframe 

         下列属性自动产生：Time   Snap-Criteria   Interpretation-origin 
                           Pick-Quality  (地震解释，ASAP,AutoPix) 
         逆断层由 Horizon  Patches 进行管理  （1，2，3）LCS( Local   Coordinate   
System) 

IESX     ing-f/dev/rmt/on  fsf/  绕过另一个文件 
解锁     $CL     大写 

         $IESXPROG/Da-clear 全称 
         作切割线输出，先产生 2D，后输出 

 cd    $IESXPROG     ies_Util           工具        IESX 
         1  12   22  42  44    2终止退出        其中有的    恢复工区 
Path----定义多边形----输出层位（控制范围）          收敛 
 
（四）属性，方差体产生 

   选测站，选要运行的程序----输出文件放在 Data  Manangers----Interpretation  
Data 找到可以删除删除 
（五）常见问题 

1. 优 先 级 管 理 ---Baspman---user---preferme---presence1,2,3---3—2—1 切

----surveys 
2. 手工加的 marker显示不出来。在 Source中加入 GF-Loader 
3. 输入层位必须是缺省 5项记录  X   Y   line  CDP  Time 
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4. 将 IESX 中的层位按 X，Y，Z 输出，作为离散文件加入，将离散文件网格
Gridding,再将网格文件还原成 Surface (Data  Manage---解释---Surface完成 

5. 属性产生与删除， 在数据管理下解释数据中删除 
6. 移动底图上粘贴顺序 
7. 斜线的切割 
8. 数据加载中 Raviable     fix  
9. 计算井斜-----倾角问题 
10. 加入深度域的地震数据，在剖面显示中 User—改变显示状态Metric缺省的是 
11.  User----refrenence----Fault(从 Segment---(变成) Symbol)能把断层的闭合点显
示大一些 

 
五．Geoviz. 可视化   （相干数据体）  Geoviz  explore 

Data   Manage—Geoviz—只有显示功能 
Visualization  
File—Volume  Load (三维数据体加载)      看有没有空洞，颜色是否均匀 
去掉不要的东西—点黑  如  Box  Map 等        
----在 Tools—Modify下修改颜色    对地震 
                                网格 
                                层位/断层体 
 Tools—Volume—Pan—解释（如加断层）必须在+状态解释    

右键退出解释状态 
Fault  Surface/Volume    (产生断层面) 
解释完后可以可以产生断层面，以后的断层解释可用 
     XN         GT        R         O 
                 外推      限制      不限制 

Shift+P  去掉立体框 
Voxel  Picking—种子体检测   Shift+1键点种子点 
Covert  Detected  Volume—产生层位体—输出层面  存顶，底 

1.井为空井 （0，0） 
2.空 2D,3D Surface 
3.2D导航数据出错     出现故障而不能找到数据 
4.速度异常 

 Tool—Modif—修改层位—Coloning—Chang  Attribute—选 Grid （ 产生各种
属性数据体的时间网）--Modify Object—Modify Surface—Coloning  Grid—改变
颜色 
      

 

 

 



 

Geofram 4.0 版本软件使用手册 
 

第一部分  基础知识 

一、系统介绍 

Geofram 4.0 系统是 schlumber 公司针对解决测井、地震、油藏、

地质以及综合研究等问题开发的较为完整的集成软件。如图 1-1 所示，本

软件共划分井眼地质（geolog ）岩石物理

（petrophysics）、油藏描述(reservoir)、地震

（seismic）、可视化地震(visualization)和工

具(utility)等六个部分。系统管理配备 3 个基

本管理工具：项目管理工具（project mandge）、

工作流程管理器（process manage）及数据管理

器（data manage）。该系统具有如下特色： 

*基于 Oracle 关系型数据库管理：使得解释

参数、描述信息及离散、连续采样的信息数据，

均以数据指针信息存放在项目数据库的目录中。

数据入库后不需知道数据以什么样格式存放再

什么地方，只进行聚焦即可得到快速查询。 

*可靠的安全性：设置了用户存储权限，使

得数据管理更为方便； 

图 1-1 
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*极大提高工作效率：合理的项目配置，减少不必要的数据重复，使数

据深度、单位、坐标系统等转换更为方便，省时； 

*强大的可操作性：所有程序军采用窗口、菜单选项交互运行，加大可

视化程序。 

二、系统登陆 

当在界面敲入用户名和密码之后，出现如图 1-2 所视界面，选择

GeoFram 4.0.3 进入 GeoFram4.0 版本系统，出现图 1-3 所示界面，选择其

中 一

个 用

户，敲

入 密

码

（ pas

sword

）,当系统确认后在单击 Application manager 即可完成系统的完全登陆。

出现如图 1-4 所示界面。可选择进行下一步工作。 

 

 

 

 

图 1-2 图 1-3 



 

三、数据加载 

    进入系统后，单击系统界面中的 Data manager 管理器，出现数据管

理主窗口（如图 1-4）。 

选择loaders and unloaders 出现如图1-5窗口，其中ASCIL  Load 表

示 ASCIL 数据加载；data load 为 Dlis 数据加载；data save 表示数据存

储。其具体操作方法如下： 

a、ASCII LOAD  

ASCII load 模块主要用来加载文本数

据，具体步骤如下： 

将 ASCII LOAD 模块调入工作流程管理

器中，单击鼠标左键，则可掉入主窗口（如

图 1-6）： 

图 1-4 图 1-5 

图 1-6 
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1） 在 input file 中选择所加数据文件名称； 

2） 在 control file 中填入控制文件名； 

3） 在 create file 中可编写所加

载的数据。选择所需要的曲线； 

4） 按 run 键即可完成 ascii 数据

的加载。 

b、data load 模块。本模块主要用

途是将 LIS、DLIS、BIT、LA716 等格式的

数据加入数据库中。具体步骤如下： 

在 Geofram 的 P 包中，将 Data load 

模块调入工作流程管理器，并用鼠标左键双击，则可调入 Data load 主窗

口（如图 1-5）： 

1）、在 input file 对话框中假如你想要加入的数据文件名称（LIS、

DLIS、BIT、LA716 等格式）； 

2）、在 targetr field 中假如油田名称； 

3）、在 target well 中输入井名； 

4）、在 target borehole 中输入井眼名称； 

5）、在 producer 中输入公司名（可选）； 

6）、点击 run 按纽，即可将所要数据加入数据库中。 

 

图 1-7 



 

第二部分 资料预处理（well edit） 

因为各种井况、仪器、人为等因素造成测井原始资料深度不统一、

局部出现畸点等，因此在室内对其进行修改和编辑非常重要，Geofram 系

统软件就提供这样一个方便快洁的编辑模块——well edit 模块，我门可

以利用它来队原始数据资料进行处理。其工作步骤如下： 

一、 进入编辑窗口，如图 2-1所示进入 p包后直接选择Welledit 

模块即可。 

二、点击 Welledit 右键出现图 2-2 窗口。其中 inspect 表示聚焦选择

井文件，run 表示运行程序，exit 表示退出该模块，abort 表示中断目前

运行方式。 

 

 

 

 

 

 

 

 

 

 

图 2-1 

图 2-2 图 2-3 
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三、聚焦数据后即可进入 welledit 编辑模块主界面。如图 2-3 所示，

然后根据需要分别点击 Edit 、depth match 和 splice 模块，可以根据需

求进行井编辑，其中部分快捷功能键用途说明如下： 

各快洁键使用说明如下： 

 

 

 

 

 

 

 

第三部分  Utility Plot 

 

Utility Plot是 Geofram 

系统中的一个交会图工具模

块，主要功能是进行 XY 交会

图、XY-Z 值图、直方图、玫

瑰图等，主要窗口如图 3-1。

该模块使用方法如下： 

1、 点击 Data Focus 模块进行数据聚焦，即选择交会曲线所在位置； 
图 3-1 



 

2、 在 Top 和 Bottom 选项中分别输入所交会曲线的起止深度； 

3、 在 Application Type 选项中选择所需要图形类别，分别为 Cross Plot 

(交会图)、Z Plot (Z 值图)、Historm(直方图)、Polar(极坐标图)等，

现以交会图为例进行说明。 

4、 单击 Presentation File 按钮

出现图 3-2 所示图版，依据需

要选择所需要的类型； 

5、 单击 Overlay File 进入图 3-3

所示图版，依据需要选择所需

要的类型； 

6、 选择 X、Y 所对应曲线； 

7、 单击 Run，进入图形显示窗口（图 3-4），即可完成本次交会工作。 

    注：完成以上步骤后可以根据

需要对所选择曲线进行优选编辑、

回归。 

 

 

 

 

 

图 3-2 

图 3-3 
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第四部分  常规测井资料处理技术（PVP） 

    对于常规资料处理模块，目前只有 PVP 和 ElanPlus 两种，在这两种模

块之中，前者所需参数相对较少，应用层次明显，做法相对简单；而后者

所需参数多，计算复杂，因此，本文主要对 PVP 处理模块进行说明。 

 

第五部分   特殊资料处理（声、电成像） 

一  电成像的处理流程 

该套软件可以处理三大测井公司的多系列电成像及井周成像资料，电成

像包括 FMI、ARI、STARII、EMI，井周成像包括 USI、CBIL、CAST。对于这

些测井系列，其处理原理和过程基本一致，其处理框图见图 1。 

图 3-4   



 

 

数据的转换与加载 

对于斯伦贝谢的测井资料是先数据加载，再通过 BHGeol Formatter 将

原始数据包解压，快慢道数据分开，检查数据的完整性。而对于另外两家

测井公司的资料则是先利用 BHGeol Converter 进行数据转换，再将数据加

载到数据库中。 

 2)  GPIT Survey 磁场及加速度数据的质量检查，GPIT 的正确与否是

进行余下处理的关键，正确的磁场资料和加速度资料其 X 和 Y 轴的分量应

是以 O为中心的圆或弧。 

BorEID  对数据进行预处理，并形成静态图象资料 

 对数据进行环境、加速度及死电极的校正，校正后的数据进行均衡处

理，输出静态平衡的图象，该图象反映了整个测量井段的微电阻率的变化。 

BorScal  微电阻率成像测井资料的刻度 
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 成像测井的微电阻率与微球测的浅电阻有一定的差别，用浅电阻率（冲

洗带）刻度成像的微电阻率，使其比较准确的代表井眼周围的地层。该模

块只对定量计算裂缝参数时才有用，且只适用于斯伦贝谢的成像测井资料。 

BorDip 自动计算构造倾角或沉积倾角 

 用相关对比法自动计算地层倾角。可以改变计算的窗长和步长分别求

取构造倾角和沉积倾角。 

BorNor 图象的动态加强   

 输出的静态图象是全井段大范围电阻率变化之间的颜色刻度，由于有

限的颜色资源，使静态图象不能清晰的反映井眼地质特征。图象的动态加

强是在每 0 . 5 米配一次色，这种图象可用于识别岩层中各种细微的特征

和构造变化。 

BorView  人机交互解释 

 这是微电阻率扫描成像测井最

关键的一步，通过人机交互解释，识

别出资料上反映的各种地质特征如

沉积构造、裂缝等特征，并进行详细

的计算及统计。 

8）Data  Save 数据输出 

 将处理解释的各项结果存盘输

出，并对裂缝进行定量计算。 



 

二 偶极子横波的处理流程 

该软件只处理斯伦贝谢的偶极子横波资料。其处理流程比较复杂，包括

资料的预处理和解释处理。 

（一）资料的预处理 

其预处理流程见图 2主要分以下几个步骤： 

1、DataLoad  数据的加载 

2、SWP 读取声波波形数据，对输入的数据进行解压、预处理，输出一

些后处理所必需的输入参数，产生波形数据集； 

3、STC 计算出时差/时间平面上的所有相似系数值，通过峰值的最大相

关性在平面上形成一个等高线图，在等高线图上最大相关峰值给出了时差

和时间。 

Sonic Labelling 声波标定 

 在 STC 计算输出的峰值矩阵中进行峰值标定，求出相应的纵、横及斯

通利波时差。 

Label Editor 标定声波的编辑   

对提取的声波时差进行编辑。 

6、MBHC 对提取的纵波、横波及斯通利波时差进行井眼补偿校正。 

7、SPP 用来计算 Vp/Vs，泊松比以及纵波、横波及斯通利波的传播时

间。 

（二）解释处理 
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偶极横波资料可以用来进行地层评价，进行地层各向异性分析、岩石机

械强度分析，目前我们主要有以下几个方面的应用。 

斯通利波的处理应用流程 

具体的流程见图 3。 

Sonic  Fracture  利用斯通利波指示裂缝的张开度 

斯通利波在遇到裂缝时，其透射波和反射波会发生变化，利用计算的透

射系数与反射系数

的结合，可以提高裂

缝评价的效果，反映

裂缝的有效性，反射

系数的大小在一定

程度上反映了裂缝

的张开度，但目前还

没有岩心资料来标

定，因此还只是半定

量的分析。 

2） Stoneley permeability 利用斯通利波计算地层渗透率 

 斯通利波的传播受各种因素的影响，其中包括骨架渗透率和开口裂缝。

因此斯通利波的时差、幅度衰减等异常往往和地层渗透性有很好的相关性。

根据毕奥模型，利用测量的斯通利波时差与计算的弹性的斯通利波的时差



 

来计算渗透率，在计算弹性斯通利波时差时关键的参数是泥浆时差。另外，

利用纵波、横波时差与地层密度合成的理论上的斯通利波时差(DTSTE)与实

测的斯通利波时差的差值，可以作为流体移动的指数。 

 3)Sonic Waveform Energy  利用该模块计算斯通利波的微差能量 

判断地层裂缝的有效性。当井壁有有效裂缝存在时，则钻井液沿着裂缝

流进或流出，从而消耗斯通利波的能量，使其幅度降低，反之在无效缝处

就不会产生能量衰减，但还要注意

泥饼的影响，因泥饼要阻止流体在

裂缝中流动，微差能量越大，说明

裂缝的有效性越好。 

偶极横波的处理应用流程（见

图 4） 

1）Four-Component Rotation

四分量旋转 

当横波以倾斜角入射到裂缝时

会发生横波的双折射，分裂为快慢

横波，快横波的极化方向平行于裂

缝的走向，而慢横波的方向垂直于

裂缝的走向。快慢横波到达接收器

的能量将随仪器方位的变化而变
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化，利用四分量旋转法可计算出快慢横波波形。 

Anisotropy Post Process 各向异性分析 

然后再根据时差—时间域相关处理计算快慢横波时差、时间及波速,利

用计算的时差、时间及波速计算出交叉分量能量和各向异性系数。交叉分

量能量指示各向异性，交叉分量的最大和最小值之间的差值很大时，表明

存在各向异性，当最小分量接近于零，可以精确的计算出快横波的方位，

确定裂缝发育的走向。各向异性系数包括利用横波的时差和时间计算的地

层的各向异性，结合交叉分量来准确判断地层的各向异性。根据各项异性

结果可以提取的快横波方位，其与裂缝的走向一致 

 

第六部分  Geology Office 用户练习指南 

启动 Geology Office  

Geology Office 的启动流程 

log into a project 

从 Application Manager 中，选择 Geology 目录 

从 Geology 目录中，双击 Geology Office 



 

Geology Office 基本环境设置 

 

通过该功能，用

户可以设置 Geology 

Office 主窗口的应

用模块图标，应用模

块的启动方式等。 

Geology Office 

主窗口中，选择 File 
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→ Session 条目。启动 Session Manager 窗口。 

在 Session Manager 窗口中，根据用户需求，设置选项。 

 

第一节  WellPix 用户使用指南 

说明:WellPix  主要用于多井小层对比,岩性层段解释 

WellPix 启动的两种方法: 

从 Geology office 主界面双击 WellPix,该方法启动的 WellPix 界面中

没有井地数据。 

从 basemap 中,选 send> crossection，然后移动光标到所选中的

crossection,按MB1,所选中的crossection边黄色, 此时按MB3>WellPix, 

WellPix 主界面打开,此时界面中已有 crossection 中所有的井的数据. 

2.  选择小层对比所需参考曲线: 

在 selection Mode 下选中某口井如 34/10-B-12 井; 

选 Edit>Add track/curve,弹出下面窗口 

 

 



 

选择所需曲线, OK 后弹出下面窗口,Yes 使所有井拥有该曲线道. 

3.地质层位对比: 

选主菜单 Interpretation>Surfcae/Marker Manager 或 Create Marker  

按钮;  

在 Surface Manager 界面,打开 horizon 按钮; 

点击 New 打开 Horizon Editor, 输入 test 建立一新的地质层位,OK; 

在 Surface Manager 界面,选 test 层 ,在 Marker type creation 下选

strat 图标,进入 Marker Creation mode; 

将光标放在所要解释的井如 34/10-B-12 井地层分届处,按 MB1,建立一

个名为 test 的 Marker; 

按类似方法建立与该井相应的 test marker。 

特别提示： 
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断层,油水界面标识的建立方法与地层 Marker 建立类似. 

利用 Ghost Curve 进行测井曲线对比 

1.按 Scroll Lock 按钮,同时调整主办者界面中的井深度到目的深度,

然后 

关闭 Scroll Lock； 

2.按 Ghost curve  图标,进入拉 log correlation  模式； 

3.选择对比井的 测井曲线道如 GR 道,在须详细对比的曲线段按 MB1 并

拖拽,在释放 MB1 时就产生该段的 Ghost curve； 

4.按下 MB1 并拖拽可以移动 Ghost curve  到任意位置与其它井的该曲

线进行对比; 

5.按 Create Anchor Point  按钮在 Ghost curve  上建立曲线拉伸压

缩的定位标志,按下 MB2 可进行 Ghost curve  的拉伸,压缩. 

6. 双击 Ghost curve  可对 Ghost curve  属性进行编辑,从

view>remove Ghosts  将 Ghost curve  从界面中消失. 

岩性段 Lithozon 的解释 

1.对单井井进行岩性段解释 

选择解释的目的井。 

在 wellpix 主界面选 interpretation>Create Zone>single zone。 

interpretation ,打开 single litho zone interpretation 窗口。 

打开 zone version 选择界面，建立新的或选择已有的 lithozone  解



 

释方案。 

按层位 layer 或指定上下界面来确定岩性区带范围； 

在 zone attribute 中，选择适合该解释层段的岩性符号及颜色，ＯＫ。 

２．对多同时解释多层段岩性：该方法的前提是已有井进行了目的解释

井的层段岩性解释，且目的井已解释了相应的参考井所解释的 Markers。 

在 wellpix 主界面选 interpretation>Create Zone>multiple zone 

interpretation ,打开 multi litho zone interpretation 窗口； 

选择层位的解释方案 zone version; 

选择层位解释的上下界线：top surface,bottom surface; 

在 zone between marker 界面中，选择解释好的参考井 reference 

borehole; 

从 borehole 按 钮 打 开 select borehole for multi zone 

interpretation 窗口，选择需要进行解释的目标井，ＯＫ； 

特别提示： 

１．在 wellpix 中，对任意目标进行解释之前都必须选中， 

２．井位 borehole 的选中标志是井的左上右下放两点标记；道 track

的选中标记为三点标记． 

第二节  ResSum 使用说明 

注意：ResSum 使用 WellPix 的对比结果。该说明均基于 WellPix 的输

出结果。 
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Process Manager 

在 ProcessManager 的处理链中，ResSum 应在 WellPix 之后。ResSum

模块可从 ProductCatalog 的 Geology 中调出。 

启动 ResSum，弹出以下窗口 

 

在 Setup 栏目中，点击 Summation Model，弹出如下窗口 

该窗口列出了 ResSum 保存的所有统计结果/版本。选择相应的统计版

本。 

点击 Create⋯按钮，弹出如下窗口,创建新的 ResSum 统计版本。 



 

 

在 Summation Model 栏内输入统计版本名称。点击 Zone Version⋯，

选择适当的 WellPix 对比版本。点击 Edit by Layers 书签，点击 Layers⋯，

选择适当的 Layers。点击 Boreholes⋯，选择需统计的井。点击 OK，新的

统计版本即创建完毕。 

在主窗口中，点击 Setup 栏中的 CurveSelection⋯按钮，弹出如下窗 
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分 别 点 击 Volume of Shale/Clay, Gamma Ray, Porosity, 

WaterSaturation 和 Permeability 按钮，选择适当的截止曲线。若还需使

用其它截止曲线，可在 Curve 1 Code 和 Curve 2 Code 栏目内输入相应的

截止曲线。点击 Selected Log Curves⋯按钮，可检查截止曲线的输入状

态。点击 OK 键，确定截止曲线的选取。 

在主窗口中，点击 Setup 栏中的 Properties⋯按钮，选择所需的统计

参数类型。如以下窗口所示 

 



 

 

 

在主窗口中，点击 Setup 栏中的 Global Cutoff Set⋯按钮，弹出如下

窗口 
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分别输入相应的统计截止值。点击 OK 确定输入结果。 

7.在主窗口中，点击 Setup 栏中的 PropertyVersion⋯按钮，可选择以

前的统计结果进行查看。若需要建立新的输出版本，可直接在 

PropertyVersion⋯栏中输入相应名称。 

8.在主窗口的中部和下部，分别列出了所选择的井及 WellPix 对比的分

层结果。可使用窗口列出的以下图标对井及分层进行编辑(增加或删除)。 

9.点击主窗口下的 Compute⋯按钮，输入相应的统计采样率，ResSum 将

自动进行统计，并将结果存入所建立输出版本中。 

10.点击主窗口下的 View⋯按钮，可对统计结果进行显示编辑。如下图

所示。 

 

 

以上过程可完成 ResSum 的基本功能。详细的功能描述，请参阅 ResSum



 

使用说明书。 

第三节   Cross Section 用户使用指南 

Cross Section 的启动 

CrossSection 的启动，可以在 Geology Office 主窗口中点击

CrossSection 图标，也可以在 BaseMap 主窗口中点击创建的过井连线。 

在运行 CrossSection 之前，必须在 BaseMap 中创建过井连线。 

在 Geology Office 主窗口中点击 CrossSection 图标。选择需绘制的过

井连线（Cross Section）。 

在 CrossSection 主窗口中，选择 Edit → Layout 弹出 Cross Section 

Layout 窗口。设置 Cross Section 显示参数。 

Cross Section 解释 

• 添加地震数据背景 

在 CrossSection 主窗口中，选择 Edit → Seismic，弹出 Section 

Seismic Edit 窗口。如下图所示。  
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在 Section Seismic Edit 窗口中，点击 图标，定义需要的地震数

据。如下图所示。 

 

在 Section Seismic Edit 窗口中，设置必要的显示参数，如颜色，增

益等。 

点击 OK 完成地震背景数据添加。 

• 创建断层 

在 CrossSection 主窗口中，选择 Edit → Hinge。 

在 Cross Section Borehole Hinge Edit 窗口，点击 图标，选择所

有的井用于绘制连井剖面图。（用户也可单独选择需要使用的井进行绘制）。 

在 Cross Section Borehole Hinge Edit 窗口，设置所需的井绘制参数

（绘制模式，模板等）。点击 OK 完成上述设置。 



 

在 CrossSection 主窗口中，点击 图标，弹出 Correlation and Pick 

Edit 窗口。如下图所示。 

 

在 Correlation and Pick Edit 窗口中，点击 图标，弹出 Create 

Surface 窗口。如下图所示。 

 

 

在上述窗口中，输入要创建的断层名称，设置断层类型，颜色等。点击
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OK，创建新的断层。 

在 Correlation and Pick 窗口中，选择要创建的断层，使用鼠标在

Cross Section 主窗口中绘制（创建）断层。如下图所示。 

 

特别提示： 

在进行上述编辑时，鼠标的使用方法如下： 

MB1：用于创建断层点（Pick)。 

MB2：用于反回上一个创建点（undo)。 

MB3：用于弹出用于编辑的功能菜单。 

若使用 MB3，须将键盘的 Num Lock 键释放。 

• 显示 Markers 

在 Cross Section 主窗口中,选择 Interpretation → Baseline，弹出



 

Baseline Edit 窗口。如下图所示。 

在 Cross Section 主窗口中,选择需粘贴 markers 的井（用鼠标点击井

名）。 

在 Baseline Edit 窗口中，选择 Marker 标签。点击 Associate 按钮，

选择 Marker 道。 

注：Marker 道的创建需在 Compoiste 模块中进行。 

若要对所有的井粘贴 Marker，需单独对每口井做上述操作。 

• 绘制 Correlations 

在 CrossSection 主窗口中，点击 图标，弹出 Correlation and Pick 

Edit 窗口。 

在 Correlation and Pick Edit 窗口中，点击 图标，选择要绘制的

Surfaces. 

在 CrossSection 主窗口中，选相应的 Surface。在 CrossSection 主窗

口中，用鼠标创建数据点，绘制 Correlation 线。 

 

第七部分  RockCell 培训练习指南 

需必备的基本知识 

在使用本指南前，用户需具备基本的 GeoFrame 软件应用技能，应熟悉

GeoFrame 的数据库管理，数据加载，曲线编辑及绘图模板编写，会使用

Geology Office 中的 WellPix，ResSum 和 BaseMapPlus 等模块。 
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练习目标 

通过本练习指南，用户将会掌握 

　 利用 RockCell，创建并培训非督导（UNN）/督导（SNN）神经网络。 

　 利用上述神经网络判定地层的电相/岩相特征。 

　 评估缺失曲线。 

　 根据 RockCell 计算分析结果，利用 BaseMap 模块绘制岩相/岩性的

横向分布图。 

RockCell 工作流程 

 

 

 

 

 

 

 

 

 

数据准备 

工区显示单位选用”米”制 

数据加载使用 Rockcell_Training_RM.gf66, 使用 DataLoad 将上述数



 

据加载至培训工区的 RM 油田中。 

非督导神经网络分类 

Unsupervised Artificial Nueral Network (UNN) Classification 

在进行非督导分类时，利用测井曲线数据，在计算过程中无须使用先验

的样本数据。数据通过其自身特征进行分组或聚类，最终根据不同的聚类

特征确定不同的岩性或岩相。 

练习一：利用非督导神经网络（UNN）确定地层电相 

数据选择和加载 

将数据聚焦到 RM 油田。 

在 Process Manager 窗口中，双击 RockCell 模块，启动 RockCell 应用

窗口。 

在 rockCell 应

用窗口中，从菜单

File → Load 中，

打开 Data Loading

对话窗口。 
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点击 Data Loading 窗口左上角的选择菜单，选择相应的井。 

选择 RM Field。 

利用右箭头图标，选择以下井用于练习。 

Diamond, Emerald, Jade, Ruby, Sapphire 

点击 Common Codes⋯弹出 Common Channel’s Codes 对话框， 显示不

同关键井中的通用曲线名。 



 

 

 

选择下列曲线 

DT，GR，RHOB，NPHI，PEF，RT，RXO，PHIE，MORPHO_TYPE 

在 Code Set 中，输入 RockCell_EX 名称。 

►点击 图标，选择 Update Code Set 更新/创建相应 Code Set。点击 OK

关闭 Common Channel’s Codes 窗口。 

点击 Date Loading 窗口左上角的选择菜单，选择 Channel Bindings。 
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对每一口井检查曲线的选择是否正确。 

点击 Close 关闭 Data Loading 对话窗口。 

创建井曲线显示模板 

在 RockCell 主窗口，从菜单 View → Borehole Template 中，启动

Playback Presentation Inspector 对话窗口。 

 

 



 

在 Playback Presentation Inspector 对话窗口中，设置 Top = 3000m。 

点击 Run，开启 Borehole Template Editor(RockCell)窗口。 

在数据聚焦中选择 Diamond 井。 

如下图所示设置曲线显示模板。 

Borehole Template Editor 窗口，选择菜单 File → Save Presentation 

As，将绘图模板保存至文件名 rockcell_ex.lgp。 

 

退出 Borehole Template Editor 窗口。 

在 RockCell 主 窗口中，选择菜单 View →  Multi Borehole 

Presentation⋯，打开 Presentation Setup 对话框。 
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在 Presentation Setup 对话

框中，按顺序选择显示以下井。 

Diamond，Emerald，Jade，

Ruby，Sapphire 

设置 Display Top = 3000m 

选择 rockcell_ex.lgp 作为

绘图显示模板。 

将井显示间距设置为 1cm。 

点击 OK，显示测井数据。 



 

在 RockCell 主窗口中，点击 图标，设置全局显示比例为 1：2000。

并按以下井段显示个井数据。 

Diamond 3718 ~ 4017 m 

Emerald 3823 ~ 4074 m 

Jade  3832 ~ 4125 m 

Ruby  3270 ~ 3637 m 

Sapphire 4416 ~ 4727 m 

至此，RockCell 的基本设置已经完成。 

创建样本点数据（Sample Facies ) 

UNN 要求输入的样本点数据，应包含关键井中的各种电相特征。 

在 RockCell 主窗口中，点击图标 ，击活交互分层功能。 

在 Diamond 井中，按住鼠标左键并拖动鼠标，选择全井段，然后点击鼠

标右键，选择 New facies，打开 Zone Attribute 菜单。 
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在 Zone Attributes 窗口中，保留隐含设置。相名称 rockcell_facies_n

只是创建用于非督导的神经网络。 

点击 Attributes 按钮，改变其设置为 Dimensions。 

输入 Top Depth = 3730m，Bottom Depth = 4000m。 

点击 OK 关闭 Zone Attributes 窗口。 

创建并培训非督导的神经网络（UNN） 

在 RockCell 主窗口中，选择菜单 Process → Neural Network → 

Dataset Management，打开 Dataset Computation 对话窗口。 

 

点击 New Dateset 按钮，输入 UNN_Set 作为新的 Dateset 名称。 

在 Dataset 的 Common Codes 选项中，保留隐含设置。 

在 Dataset 的 Boreholes Selection 选项中，选择 Diamond 井作为关



 

键井。 

 

保存上述设置，并关闭 Dataset Computation 对话窗口。 

 在 RockCell 主窗口中，选择菜单 Process → Neural Network → 

Network Management，打开 Network Computation 对话窗口。 

在

Network 

Computation

窗口中，点击

New Network

按钮，将 UNN

网络名称改
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为 UNN_1。 

点击选项按钮，选择 General Parameters 选项。 

在 Network Class section 面板中，选择 Unsupervised。 

在 Problem Class section 面板中，选择 Classification。 

点击选项按钮，选择 Data Selection 选项。 

在 Training Set 中选择 UNN_Set。 

点击选项按钮，

选 择 Training 

Parameters 选项。 

 

 

 

 

 



 

在 Layer Parameters 面板中，输入 Number of Facies = 5。（根据你

需要识别的相类型数量而定） 

保持其它的隐含参数不变。 

点击

Training 

Network 按

钮，对网络进

行培训。 

点击 Close 按

钮 关 闭

Training 

monitor 窗

口。 

 

如果培训结果满意，点击 Save Network 保存培训结果。点击 图标，

可显示培训网络的相特征。 
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点击 Close 按钮，关闭 Network Computation 窗口。 

特别提示： 

在本练习中，根据 Diamond 井数据，将全井段数据分为 6类不同的相特

征。 

使用 UNN（UNN_1）评价岩相曲线 

在 RockCell 主窗口中，选择菜单 Process → Estimation，打开

Estimation 对话窗口。 



 

 

在 Computation using⋯面板，打开 Unsupervised Nets 选项。 

在 Target Boreholes 面板中，选择 Diamnod，Ruby，Emeraid，Jade，

Sapphire 井。（使用<Ctil>+MB1，进行多项选择） 

点击 Edit Parameters set 按钮，打开 Parameter Set Builder 对话窗

口。 

 

在 Parameter Set Builder 窗口中，点击 New Set 按钮。 
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将隐含的 Set Name 设置为 UNN_Set1。 

选择 Select network model 选项。 

在 Select network model ▼选项中，点击 按钮，显示并选择前面练习

中培训/创建的网络（UNN_1 )。 

点击 Close 按钮，关闭 Parameter Set Builder 对话窗口。 

在Estimation对话窗口中，在Parameters sets选项中，选择UNN_set1。 

设置 Top of the Zone = 3000m。 

 

点击 Estimate Log 按钮，打开 Estimation Name 对话框。 

设置计算结果名称为 UNNEstim1。 

点击 OK，进行计算。计算结果将自动更新显示在 RockCell 主窗口中。

同时计算结果将存储在 RockCell module run 的 UNNEstim1 名称下。 

 



 

 

关闭 Estimation 窗口。 

利用交会图检查计算结果 

在 RockCell 主窗口中，选择菜单 View → CrossPlot，或点击交会图

图标 ，打开交会图窗口。 

点击 Set Up 设置显示特征。选择一口或多口井，设置 X 轴为 NPHI，Y

轴为 RHOB，选择 Estimated-Z-Plot 绘图类型。 
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在 RockCell 主窗

口中，选择菜单 File 

→ Save Model 保存输

入的相样本数据，计算

模型，数据组及培训的

网络。 

在 RockCell 主窗口中，选择菜单 File → Save Results 保存最终计算

结果。 

退出 RockCell。 

 



 

岩相类型编辑器简介 

岩相类型编辑器可以在不同的应用模块中调用，如 Date Manager, 

Geology Office 应用程序和 General Data Manager。在数据库中的岩性模

块组中，有 9 个通用的保留岩相类型，即 Shale，Coal，Siltstone，

Sandstone，Evaporite，Limestone，Dolostone，Metamorphic 和 Igneous。

上述岩相的颜色和模板可以进行编辑，但岩相名称及其 ID 号码不可编辑。

岩相名称 rockcell_facies_n 是由 RockCell 和 BorTex 应用非督导的神经

网络（unsupervised neural net）产生/创建的，其 ID 号码从 9000 开始。

对于保留的和其它的岩相，其 ID 码从 0， -1， -2⋯~8999。 

练习二: 岩相类型编辑器 

启动 GeoFrame Application Manager, 点击 Data。 

在 Data Management Catalog 窗口中，点击 Tools 文件夹，选择双击

Lithofacies Catalog Editor。 

检查并确认下表中的岩相，若需要，请进行必要的编辑。 

 

 

点击 Apply 保存并关闭 Lithofacies Catalog Editor 窗口。 

督导的神经网络分类 

Supervised Neural Network （SNN）Classification 

在督导的神经网络分类中，需应用先验的分类资料对神经网络进行培
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训。 

练习三：利用督导的神经网络判定地层岩相 

在 Process Manager 中，将数据聚焦至 RM 油田，启动 RockCell 模块。 

在 RockCell 主窗口中，选择以下井： 

Agate，Diamond，Emerald，Fluorite，Garnet，Jade，Opal，Peridot，

Ruby，Sapphire，Spinel，Zircon 

同时选择以下曲线类型： 

DT， GR，RHOB，NPHI，PEF，RT，RXO，PHIE，MORPHO_TYPE 

在 RockCell 主 窗 口 中 ， 选 择 菜 单 View →  Multiborehole 

Presentation，显示所选择的井曲线。 

特别提示： 

需显示的井为： Diamond，Emerald，Jade，Ruby 和 Sapphire。 

在 RockCell 主窗口中，选择图标 ，打开绘图比例设置窗口，设置

绘图比例为 1/200。 

定义样本岩相（Key Facies） 

在 RockCell 主窗口中，点击图标 ，进入交互式层选择状态。 

在 Diamond 井曲线图中，设置以下样本岩相点： 

 

 

 



 

在 RockCell 主窗口中，点击图标 ，打开交会图窗口。 

在交会图窗口中，选择 Diamond 井，设置 X 轴为 NPHI，Y 轴为 RHOB，

选择交会图类型为 X-Facies-Plot。绘制交会图，检查样本数据的分布。 

 

 

 

在 RockCell 主窗口中，选择菜单 File → Save Models 保存在 Diamond

井中定义的相。 

创建督导的神经网络（Supervised Neural Network-SNN) 

在 RockCell 主窗口中，选择菜单 Process → Neural Network → 

Dataset Management，打开 Dataset Computation 对话框窗口。 

在 Dataset Computation 对话框窗口中，点击 New Dataset 按钮，输入
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Dataset 名称 SNN_Set1。 

点击选项列表按钮，选择 Common Codes 选项。 

保持 Selected Common Codes 列表中的设置不变。 

点击选项列表按钮，选择 Borehole Selection 选项。 

在 Selected Key Boreholes 列表中，只选择 Diamond 井做为关键井。 

点击 Close 关闭 Dataset Computation 对话框窗口。 

在 RockCell 主窗口中，选择菜单 Process → Neural Network → 

Network Management，打开 Network Computation 对话框窗口。 

在 Network Computation 对话框窗口中，点击 New Network 按钮，设置

网络名称为 SNN_1。 

点击选项列表按钮，选择 General Parameters。 

在 Network Class 选择面板中，选择 Supervised。 

在 Problem Class 选择面板中，选择 Classification。 

 



 

点击选项列表按钮，选择 Data Selection。 

选择 Training Set 名称为 SNN_Set1。 

确认培训使用的输入曲线。 

确认培训的输出曲线为 MORPHO_TYPE。 
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点击选项列表按钮，选择 Training Parameters。 

设置最大叠代参数 Max Number of Iterations = 100。 

设置网络层数 Number of Layers = 2，每层的节点数 Nodes = 10。 

其它的参数保持隐含不变。 

点击 Train Network 按钮，启动培训进程。观察 Training Monitor 窗

口。 

在培训过程中，误差曲线应该逐渐递减。否则，需检查或调整样本数据，

输入数据或网络参数。 

 



 

 

利用督导的神经网络（SNN）评估岩相特征 

在 RockCell 主窗口中，选择菜单 Process → Estimation，打开

Estimation 窗口。 

在 Estimation 窗口中，选择 Other models and nets。 
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选择 Diamond 井做为关键井。 

点击 Edit Parameters Set 按钮，打开 Parameter Set Builder 对话框。 

在 Parameter Set Builder 对话框中，点击 New Set 按钮，设置隐含参

数名称为 SNN_Set1。 

在 Parameter Set Builder 对话框中，选择 Selected network model

▼选项，点击 按钮，选择 SNN_Set1。 

点击 Close，关闭 Edit Parameters Set 对话窗口。 

在 Estimation 对话窗口中，点击 Parameters Set 下的列表选择按钮，

选择 SNN_Set1。 



 

设置 Top = 3200m, Bottom = 4020m。 

保持 MORPHO_TYPE 做为 Evaluated Log Code。 

点击 Estimate Log，打开 Estimation Name 对话窗口。 

输入 SNNEstim1 做为成果输出名称，点击 OK 开始进行岩相判定。判定

结果将直接更新显示在 RockCell 主窗口中。 

 

 

 

利用交会图检查判定结果。 
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对其它井重复上述步骤，将判定结果输出到 SNNEstim2 中。 

 

使用交会图检查判定结果，保存计算结果。 

退出 RockCell。 

练习四：用督导的神经网络评估缺失曲线 

在以下练习中，将对 Sphene 井中的 RHOB 缺失曲线进行评估。在评估缺

失曲线前，必须首先创建一条空的缺失曲线。（为什么？如何创建？） 

数据选择及输入 



 

将数据聚焦至 RM 油田。 

选择以下井： 

Diamond，Sphene，Sapphire 

选择以下曲线： 

DT，GR，RHOB，NPHI，PEF，PHIE，RT，RXO，MORPHO_TYPE 

井数据显示 

绘图模板选择 rockcell_ex.lgp。 

绘图比例设置为 1：2000。 

各井的测井数据井段为： 

Diamond 3718m ~ 4017m 

Sphene 3823m ~ 4074m 

Sapphire 4416m ~ 4727m 

样本数据选取 

在 RockCell 主窗口中，选择菜单 Edit → Lithofacies Catalog 

Editor。 

在 Lithofacies Catalog Editor 窗口中，点击图标 ，添加以下岩相： 
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在 Diamond 井中，设置以下样本井段： 

Zone1: 3739.95m ~ 3747.25m 

Zone2: 3811.95m ~ 3842.33m 

Zone3: 3854.71m ~ 3882.83m 

Zone4: 3924.46m ~ 3956.50m 

Zone5: 3965.52m ~ 3972.83m 

创建用于评估 RHOB 曲线的督导的神经网络（SNN） 

在 RockCell 主窗口中，选择菜单 Processing → Neural Network → 

Dataset Management 打开 Dataset Computation 对话窗口。 

在 Dataset Computation 对话窗口中，创建名为 SNN_RHOB1 的 Dataset。 

选择以下曲线用于网络培训： 

DT，GR，NPHI，RHOB 

选择 Diamond 和 Sapphire 作为关键井。 

在 RockCell 主窗口中，选择菜单 Processing → Neural Network → 



 

Network Management 打开 Network Computation 对话窗口。 

在 Network Computation 对话窗口中，创建新的网络名称 SNN_RHOB1。 

选择以下基本网络参数： 

Supervised，Estimation 

在 Data Selection 中，确认 DT，GR，NPHI 为输入曲线，RHOB 为输出

曲线。 

将培训参数设置为： 

Number of Layers = 1 

Nodes/Layer = 10 

点击 Train Network 按钮，对网络进行培训。 

利用督导神经网络评估 RHOB 曲线 

在 RockCell 主窗口中，选择菜单 Process → Estimation 打开

Estimation 对话窗口。 

在 Estimation 对话窗口中，选择 Supervised Nets。 

选择 Diamond 和 Sapphire 井作为目标井。 

设置 Evaluated Log Code 为 RHOB。 

在 Parameter Set Builder 中，创建新的 Parameter Set 为 RHOB_Set1。 

选择 SNN_RHOB1，作为判定网络。 

设置处理深度为 Top = 3200m，Bottom = 4400m。 

点击 Estimate Log，打开 Estimation Name 对话框。 
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输入 RHOBEst1 作为成果输出名称，点击 OK 计算评估结果。 

如果计算结果满意，对 Sphene 井进行上述同样的计算。将输出成果名

称设置为 RHOBEst2。 

保存所有模型及计算结果。退出 RockCell。 

使用 ResSum 计算灰岩的净厚度 

在以下的练习中，将通过ResSum模块计算由RockCell确定的灰岩厚度，

然后使用 BaseMap 创建灰岩的分布图。在练习中使用的 Layer 和 Zone 

Version 已经由 WellPix 创建，创建的 Layer 是基于 OSLO（Top marker）

和 DALLAS（Bottom marker）。 

定义统计/计算模型 

启动 ResSum 模块。 

在 ResSum 模块中，创建统计/计算模型。选择在前面练习中计算的井及

上述的 Zone Version 和 Layer。 

曲线选择 

在 ResSum 主窗口中，点击 Curve Selection⋯按钮。 

点击 Selected Curved⋯按钮，打开 Input Curves 窗口，设置 Lithology

选项。 

对 Diamond 井，相曲线选择 SNNEstim1，对其它井，相曲线选择

SNNEstim2。 

点击 Save 保存上述设置。 



 

在 ResSum 主窗口中，点击 Properties⋯按钮。选择 Litho Type 菜单

条，将 Limestone 和 Limestone ratio 设置为 Zone Interval。 

在 Generate 选项中，设置 Scatter set。同时打开 TST 选项。 

点击 OK 确认并关闭窗口。 

在 ResSum 主窗口中，点击 Computer 按钮，开始计算。当计算完成后，

可点击 View⋯按钮查看计算结果。 

利用 BaseMap 创建灰岩分布图 

在 ResSum 主窗口中，点击 Map 按钮，打开 BaseMap 窗口。 

在 BaseMap 主窗口中，选择菜单 Post → Interpretation。 

点击 Scatter Sets 打开 Post Surface Data 窗口。 

选择 Surface Type = Layers。 

选择在 ResSum 中使用的 Layer，选择 Litho_Thickness，设置深度索引

为 TST 或 TVD。 

点击 OK 关闭 Post Surface Data 和 Interpretation 窗口。 

在 BaseMap 主窗口中，选择菜单 Gradding → Project Gridding。修

改/设置网格和等值线参数，点击 OK 运行网格化及绘制等值线图。 

 

 

 


